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SUBJECT: MP940 START UP PROCEDURE REV C 
Document Type: MP940 Product 
Topic:   REV C 
  
     
SUMMARY:  

 
This Start-up procedure highlights the steps required when using an MP940 with 
firmware revision A05 or higher. 
 
Procedures for the Setup of MP940 & SGDH: 
1. MP940 Startup Procedure 

- 1A: for a Motion Works User 
- 1B: for a Motion Works + User 

2. Replacing an SGDH Servopack 
3. Replacing an MP940 Controller or installing a new MP940+SGDH 
 
Appendixes are included for additional look-up data and reference: 
Appendix A1 – Motion Works Folder Setup Procedure 
Appendix A2 – SGDH Parameter Setup Details 
Appendix A3 – SGDH Input Signal Parameter Setup Detail 
Appendix A4 – Unexpected Alarms and Errors 
 

ENVIRONMENT:  
SGDH Version : 00E or higher 
MP940 Version : A05 or higher 
MotionWorks : 3.53A or higher 
MotionWorks Plus : 2.14 or higher 
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Procedure 1  - MP940 START-UP PROCEDURE 
 
This procedure shows the steps to take to setup and start-up an MP940/SGDH system for the 
first time (ie. new SGDH out of the box AND new MP940 out of the box).  These steps will also 
completely reconfigure the system should there be any question of setup condition. 
 
 
 
STEP 1 
Attach MP940 
to SGDH and 
wire input 
power 
according to 
users Manuals 

STEP 2 
With power off, 
set dip switch for 
memory clear 
 
 
 
 
 
 
 

STEP 3 
Apply control power to both SGDH and 
MP940 (see note1) 
 
Immediately, the MP940 ‘RDY’ and ‘RUN’ LEDs 
will blink (this means the MP940 is initialized 

STEP 4 
With power off, Set 
the MP940 dip switch 
as normal operation. 
 
 

• NOTE 1 – Pow
powered up withi

 
STEP 5 
Apply control powe
and MP940 (see no
 
Immediately, the MP940
(this means the MP940 
and transferring default 
flash firmware to the SG
the SGDH LED section w
several seconds (15 sec
section readout shows “
“NOT” are blinking if the
wired and not masked). 

• NOTE 2 – Ove
‘2881H’ to ‘8881H
(See Sigma II ma

 
STEP 7 
 
Hardware Start up
 
(Refer Table.1 SGDH P
 for MP940 for Manual 
otherwise continue for
setting) 
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properly and all memory is cleared), and the SGDH 
LED readout will blink “bb” (trying to establish DPR 
communications).  Wait several seconds until the 
SGDH shows an “AE0” alarm, this indicates DPR 
(dual port ram) communications timeout. 
 
Note: During this step, the MP940 automatically 
executes functions 5,6, and 14 in the Servopack.  
Hence it is not necessary to execute manually as it 
was with earlier firmware versions 

er Cycle Timing:  Be sure that both SGDH and MP940 control secti
n a minimum of 3 sec of each other. 

r to both SGDH 
te1). 

 ‘RDY’ LED will blink 
is initializing the SGDH, 
parameters from the 
DH’s parameter), and 
ill go blank.  Wait 

) until the SGDH LED 
.bb” (or  “POT” and 
 over-travels are not 

 
 
 
 

STEP 6 
Check to 
indicates 
shows ‘R
LEDs are
 
 

r Travels:  If the system does not have P-OT, N-OT, reset data of Pn5
’ and Pn50B from “8883H” to ‘8888H’. This can be done from the front
nual YEA-SIA-S800-32.2), or from MotionWorks/MotionWorks+ in the 

 is completed. 

arameter 
Setting,  
 software  
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PROCEDURE 1A – MP940 Start-Up with Motion Works 
 
 

STEP 7A 
Start MotionWorks and Log-in ON-LINE. 
(port 1 light will blink when communicating) 
 
If a program already exists as in Procedure 2, then 
simply perform an “All File Transfer”.  This will 
automatically perform MP940 parameter setup and 
module configuration. 
 
If this is first time setup, an Order and Controller 
Folder will need to be set up, see Appendix A1 for 
procedure. 
 
 
 

STEP 8A 
Open the Controller Folder, open the Definition Folder, then 
open the Module Configuration file, and double click on the 
SVA module (at the top bar) to open it.   
 
It will ask “New File?”.  By clicking “OK”, Motion Works will reserve a 
new file where Fixed Parameters, Set Parameters, and Servopack 
Parameters will be stored.    
 
 

 
 
 

STEP 9A 
Select the Servopack Parameters tab. 
MW Version 3.53A – From the ‘Edit’ menu bar, 
Select ‘Copy Current Value‘. 
MW Version 3.51 and ↓  - Select ‘Default Set’ in ‘Edit’ 
menu, execute and save. 
 
This step is necessary to synchronize the MP940s data and the 
Motion Works File data.  This step loads default data into the 
Motion Works File so that values are the same as those stored in 
the MP940 after default configuration. 
 
  
 

STEP 10A 
If the system does not have OT (over travels) wired 
in, it will be necessary to mask the P-OT and N-OT 
(positive and negative over travels).   
 
 
 
 
 
 
 
This can be done two different ways:   
 
1) From the Servopack tab by setting the proper 

parameter, and then saving.   
2) From the SGDH Front Panel, (See section 7.1.6 

Sigma II manual YEA-SIA-S800-32.2). 
 
Note:  It may be necessary to set the Torque limit in the 
MP940 “Set Parameter” tab (OWC002) if an “A9F” alarm is 
encountered.  See appendix A4 for details.  
  
 

Pn50A from ‘2881H’ to ‘8881H’  
 
Pn50B from “8883H” to ‘8888H’ 
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PROCEDURE 1A – MP940 Start-Up with Motion Works 
 

STEP 11A 
From the ‘File’ menu bar, select ‘Save’.   
 
This ‘Save’ operation performs a copy of all default Servopack 
parameters from the Motion Works File to both the MP940 and 
SGDH. 
 
At this point the “COPY” 
 function is now available  
(this is useful when  
replacing an SGDH  
Servopack).  For more 
 info, see Procedure 2 
 ‘Replacing The SGDH  
Servopack’. 
 
 
 
 
Note:  At this step, default Se
Take care that these values c
values upon MP940 power-u
 
1) No battery connected to

period of time. 
2) Flash switch on MP940 
 
To change MP940 Flash, it w
works as shown below.  Then
parameters will be saved to f
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

STEP 12A 
Cycle control power to both SGDH and 
MP940 (see note 1, page 2). 
 
Upon power cycle, the parameters inside 
the MP940 are transferred into its RAM 
for runtime, and the parameters inside 
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rvopack parameters are saved into the MP940s RAM.  
ould be lost and change back to the Flash ROM 

p, if one of these conditions are met: 

 MP940 and control power is lost for an extended 

is selected on. 

ould be necessary to transfer to Flash in Motion 
 the application program and the Servopack 

lash. 

the SGDH are transferred into its RAM 
for runtime. 
 
Full Start up is now completed. 
 

 
 File:  MP940StartUpProcedure_RevC.doc  

   
                                                                    01/27/2000   

Page 4 of  4  



 YASKAWA
A World of Automation Solutions TM

 
PROCEDURE 1B - Start-Up Procedure with MotionWorks + 
 
 

STEP 7B 
Start Motion Works + and either  

1) Open an existing demo program 
such as Yaskawa’s Template 
Program (examples found on 
faq.Yaskawa.com).  It is highly 
advisable to use this template 
program because it is fully tested 
and demonstrates good 
programming practices. 

2) Create a new project, setup all 
modules, and develop a new 
program . 

 
 
 

STEP 8B 
Next, go ON-LINE with the controller (F6 or menu select). 
Note that Port 1 led (on MP940) will blink when 
communicating. 
 
Once the program is completed, it is ready for a full compile 
and download.    
 
Performing a Full Compile and Download will:  

1) Send all MP940, SGDH, External Encoder, I/O, and Network setup 
parameters  

2) Send the “system ladder” [MP940’s core modular operating 
system]  

3) Compile and send the User Program 
 
Performing a Compile and Download will: 
   1) Compile and send the User Program Only 
 

 
STEP9B 
If the system does not have OT (over 
travels) wired in, it will be necessary to 
mask the P-OT and N-OT (positive and 
negative over travels).   
 
 
 
 
 
Perform these changes from the SGDH 
parameter list located in the System 
Properties box in MW+.   
 
It will be necessary to cycle control power 
for Step8B and 9B changes to take affect. 

STEP10B 
If the MP940 Program and Register memory needs to be 
maintained over time, it will be necessary to either attach a 
battery or to copy the program to Flash (from Tools, 
Controller, Copy To Flash).  Note that to copy the information 
to flash, the program must first reside in RAM (Step 8B). 
 
Using Battery: 
Here, only the Run switch will be on.  In this case, the program is backed up in 
RAM by the power of the battery, and will be executed in RAM during run-
time.  The last change in registers (such as from an HMI) will always remain in 
memory. 
 
Using Flash: 
Here, Run/Flash/Copy switches will be on.  In this case, the program and 
register memory is backed up in Flash. Anytime the control power is cycled, 
the program and register data is copied from Flash to RAM for run-time.  
Hence, any changes in registers (such as from an HMI) will be overwritten by 
the original values set. 
 
Full Start up is now completed. 
 

Pn50A from ‘2881H’ to ‘8881H’  
 
Pn50B from “8883H” to ‘8888H’ 
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PROCEDURE 2 – Replacing the SGDH Servopack 
 
 
Step 1 – replace SGDH Servopack taking care to insure all wiring is correct. 
 
Step 2 – Turn on “RUN” and “COPY” dip switches only. 
 
Step 3 – Apply control power to both MP940 and SGDH (see note 1).   
 
Immediately, the MP940 ‘RDY’ LED will blink (this means the MP940 is 
initializing the SGDH), the SGDH LED section will go blank, and 
the default parameters will be transferred from the MP940s 
firmware to the SGDH.  Wait several seconds (15 sec) until the 
SGDH LED section readout reads “.bb” (or blinks “POT” and 
“NOT” if the over-travels are not wired and not masked).  At this 
point, all Servopack parameters that are stored in the MP940 are 
copied to the Servopacks ROM. 
 
Step 4 (only for MW+ users) – If over travels must be masked, 
they must be changed from the SGDH.  Currently, MW+ does not 
support Servopack parameter change. 
 
Setup complete! 
 
 
 
 
 
 
PROCEDURE 3 – Replacing the MP940 Co

Installing a new MP9
 
 
Step 1 – execute steps in Procedure 1: “MP940 Start-up Procedure” 
 
Step 2 – For MW users, execute Step 7A in Procedure 1A.   
 For MW+ users, execute Steps 7B, 8B, 9B in Procedure 1B. 
 
 
Setup complete!
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Appendix A1 - MotionWorks Folder Setup Procedure 
     
      

1. Go to the File Menu.  Select “New,” and “Order Folder.” 
2. Input “Order Name” (New Folder is created). 
3. Right click on newly created folder.  Select make “New” Folder, “Controller Folder”. 
4. Select Controller Type (or select “MP940”). 
5. Input Controller Name (Program name). 
6. Go to Network. Select “Yes” for Online. (Logical Port 1: CP-217, Unit No.1, Route: 

No) 
7. Go to Application.  Enter customer data, click “ok”. 

 
 

See Motion Works Users Manual for detailed information. 
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APPENDIX A2 – SGDH Parameter Setup Details 
 
This table shows the default SGDH parameters required when used with an MP940 controller.  
Step 5 of the startup procedure sets these automatically.  
 
Parameter Number Name SGDH 

Default 
Setting 

for 
MP940 

Description 

Pn000.1 Control Mode 0 9 Speed  Torque Control Mode 
Pn002.0 Speed Control 

Mode Option 
0 1 Torque Limit function activated from 

MP940 through parameter OWC002 
Pn002.1 Torque Control 

Mode Option 
0 1 Speed Limit function activated from the 

MP940 through parameter OWC01C 
Pn003.0 Monitor 1 2 2 Torque Reference Monitor 
Pn003.1 Monitor 2 0 0 Speed Feedback Monitor 
Pn004.0 Option Board 

Selection 
0 0 

SGDH will set 
inside  

memory 
automatically 

Option Board Selection 

Pn005.0 Brake Operation 0 0 Brake will be controlled by SGDH 
Pn50A.0 IO Signal Mapping 0 1 Free Allocation 
Pn50A.1 S-ON Mapping 0 8 *Use Command of DPRAM 
Pn50A.2 P-CON Mapping 1 8 *Use Command of DPRAM 
Pn50A.3 P-OT Mapping 2 2 

if don’t use 
P-OT, 

please set 
8 

SI2(CN1-42) Low Enable 
 
( 8 : Disable P-OT ) 

Pn50B.0 N-OT Mapping 3 3 
if don’t use 

N-OT, 
please set 

8 

SI3(CN1-43) Low Enable 
 
( 8 : Disable N-OT ) 

Pn50B.1 ALM-RST Mapping 4 8 *Use Command of DPRAM 
Pn50B.2 P-CL         Mapping 5 8 *Use Command of DPRAM 
Pn50B.3 N-CL        Mapping 6 8 *Use Command of DPRAM 
Pn50C.0 SPD-D      Mapping 8 8  
Pn50C.1 SPD-A      Mapping 8 8  
Pn50C.2 SPD-B      Mapping 8 8  
Pn50C.3 C-SEL      Mapping 8 8 *Use Command of DPRAM 
Pn50D.0 ZCLAMP  Mapping 8 8 *Use Command of DPRAM 
Pn50D.1 INHIBIT    Mapping 8 8  
Pn50D.2 G-SEL      Mapping 8 8 *Use Command of DPRAM 
Pn511.0 DEC         Mapping 8 1 SI1(CN1-41) Low Enable 
Pn511.1 EXT1        Mapping 8 4 SI4(CN1-44) Low Enable 
Pn511.2 EXT2        Mapping 8 5 SI5(CN1-45) Low Enable 
Pn511.3 EXT3        Mapping 8 6 SI6(CN1-46) Low Enable 
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APPENDIX A3 – SGDH Input Signal Parameter Setup Detail 
 
The following tables show the details of Pn50A, 50B, 50C, 50D, 511 from appendix A1. 
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…Appendix A3 continued….. 
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…. Appendix A3 continued…. 
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APPENDIX A4 – Unexpected Alarms 
 

Should the SGDH display show an A9F alarm, this may be due to, but not limited to  
− External Encoder disconnected - when the external encoder has been enabled through 

MotionWorks or MotionWorks+. 
− The I/O350 module disconnected - when the I/O350 module has been enabled through 

MotionWorks. 
− Set Parameter or Fixed Parameter out of range - in Module Definition : SVA (You 

should reference address IWC00F to find out which parameter setting is out of range).  
If the error is related to a torque limit out of range, see the file “MP940 Max Torque 
Reference Table” file for selection of the correct value. 

MW users:  Enter this new value in step 10A above (OWC002). 
MW+ users:  To change the torque limit, go to file menu Project/Data/System 
Variable Definition and change “sLimit_Positive_Torque” from –300% to the 
value shown in the “MP940 Max Torque Reference Table” file (be sure to multiply 
by –1 to make it a negative number), (use “sLimit_Torque” for MW+ 1.56 and 
higher).  After this is changed, it is necessary to Compile and download for the 
MP940 to accept the changes. 

− Exceeding an error window - For example, if ILC00A (position deviation) is ever 
greater than OWC00F (deviation error detection setting), an A9F alarm will be 
generated and remain latched.  Once latched, even if the current value of ILC00A 
changes to less than of OWC00F, an alarm clear must be issued to remove the A9F. 

 
Please refer to CPU error status address SW00041 to help determine the cause of the 

alarm.   For more information regarding the breakout, refer to the MP940 Software 
Manual. 
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